SAS® BI Dashboard 4.3
User's Guide
Contents

What's New in the SAS BI Dashboard 4.3 ................................................................. v

PART 1 Information for All Users 1

Chapter 1 • Introduction .............................................................. 3
  Overview .............................................................. 3
  Audience ........................................................... 3

Chapter 2 • General Information .................................................. 5
  The Workflow ........................................................ 5

Chapter 3 • Getting Started: The SAS Information Delivery Portal ........... 9
  Overview .............................................................. 9
  Open the Portal and Log On ......................................... 9
  Create a Page and Add It to Your Navigation Bar .................. 10
  Add a SAS BI Dashboard Portlet to a Page ........................ 11

PART 2 Information for Dashboard Users 13

Chapter 4 • Working with the SAS BI Dashboard Portlet .................... 15
  Select a Dashboard .................................................. 15
  Specify Display Options ............................................. 16
  Print a Dashboard or Indicator ....................................... 16

Chapter 5 • Working with Dashboards and Indicators in the Dashboard Viewer ................................. 17
  Overview .............................................................. 17
  Open a Dashboard or Indicator ...................................... 17
  Navigate in the Dashboard Viewer ................................ 18
  Display Options ...................................................... 18
  Print a Dashboard or Indicator ...................................... 19
  Create or Edit a Personal Indicator Alert ......................... 19
  Manage Comments .................................................. 21
  Work with Favorites .................................................. 23

PART 3 Information for Dashboard Administrators 25

Chapter 6 • The Dashboard Designer Window .................................. 27
  Overview .............................................................. 27
  The Objects Pane .................................................... 28
  The Workspace ....................................................... 32
  The Properties Pane .................................................. 34
## Contents

**Chapter 7 • Indicator Data**  
Overview ......................................................... 37  
Indicator Data Rules ........................................ 38  
Stored Process Indicator Data .............................. 39  
Defining Indicator Data ....................................... 40  
Create or Edit Indicator Data ............................... 42

**Chapter 8 • Ranges**  
Create or Edit a Range ........................................ 49

**Chapter 9 • Indicators**  
Overview .......................................................... 54  
Create or Edit an Indicator .................................. 54  
Indicator Displays ............................................. 59

**Chapter 10 • Dashboards**  
Overview ....................................................... 105  
Dashboard Layout ............................................. 106  
Indicator Interactions ........................................ 106  
Zooming .......................................................... 112  
Create or Edit a Dashboard ................................. 112  
Manage Dashboard Contents ............................... 114  
Set Up Indicator Interactions ............................. 115  
Controlling the Appearance of a Dashboard Using the Flow Containers ........ 116

**APPENDIX**

**Appendix 1 • Indicator Role-Mapping Properties**  
Overview ...................................................... 121  
Alphabetic List of Properties ............................... 123  
Index ............................................................ 133
What's New in the SAS BI Dashboard 4.3

Overview

The SAS BI Dashboard 4.3 has the following enhancements and new features:

- features for dashboard users
- features for dashboard administrators

Features for Dashboard Users

- You can run SAS BI Dashboard in a separate window (the dashboard viewer) rather than in the SAS Information Delivery Portal.

  When run in the dashboard viewer, the software offers more functionality than when displayed in the SAS Information Delivery Portal.

- You can zoom in and view details in a dashboard.

- You can display multiple columns in zoomed-out view.

- You can create comments for a dashboard.

- You can create and manage personal favorites.

- The software offers new display types, such as waterfall chart, vector plot, and spark lines in tables.

- The software can brush (interactively highlight) data within an indicator. Also, indicators can interact with each other.

Features for Dashboard Administrators

- You create a dashboard interactively using drag-and-drop to add indicators to a dashboard.

- The software saves files in a tree folder structure.

- You can search for existing dashboards and objects, and filter a search by a specific type of object.

- You can more easily customize and size each indicator in a dashboard, as well as the dashboard itself.
• The software offers the ability to set up indicators so that they interact with each other via events.
• You can open and view multiple dashboards on different tabs.
• You can optimize screen space when building indicators and dashboards.
• As you design a dashboard, you can preview different indicator display types to easily decide which display is most appropriate for the data to be displayed.
• You can customize fonts, font colors, and font sizes in a dashboard.
Part 1

Information for All Users

Chapter 1
  Introduction ......................................................... 3

Chapter 2
  General Information ........................................... 5

Chapter 3
  Getting Started: The SAS Information Delivery Portal ............ 9
Chapter 1

Introduction

Overview

The SAS BI Dashboard enables users to use dashboards to monitor key performance indicators that convey how well an organization is performing. Dashboards include graphics, text, colors, and hyperlinks. Dashboards are created, maintained, and viewed through an easy-to-use Web-based interface. All content is displayed in a role-based, secure, customizable, and extensible environment. End users can customize how information appears on their personal dashboards.

Audience

As is true for many SAS®9 applications, the users of the SAS BI Dashboard can be grouped based on their skills and on whether they play a role in defining and managing the system. The following table shows the three types of users of the SAS BI Dashboard:

<table>
<thead>
<tr>
<th>User</th>
<th>Description</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dashboard user</td>
<td>The ultimate audience of dashboards. This role views dashboards and uses them as a launching point for further exploration and action.</td>
<td>Executives and employees presented with dashboards as part of their intranet home page.</td>
</tr>
<tr>
<td>User</td>
<td>Description</td>
<td>Example</td>
</tr>
<tr>
<td>----------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Dashboard administrator</td>
<td>This role defines indicators and dashboards. This role is responsible for setting user access to various dashboards and for controlling the extent to which dashboard users can personalize the dashboards. This role might also be responsible for extending the functionality of the SAS BI Dashboard by creating custom code.</td>
<td>A business manager with some SAS technical knowledge, or a SAS consultant involved in the initial implementation or major overhauls of the SAS BI Dashboard who works with outside consultants and corporate developers.</td>
</tr>
<tr>
<td>IT support personnel</td>
<td>This role installs the SAS BI Dashboard and maintains its setup, configuration, and administration.</td>
<td>An IT person who is responsible for supporting application deployment and maintenance on an organization’s computer network.</td>
</tr>
</tbody>
</table>
Chapter 2
General Information

The Workflow

Overview
SAS BI Dashboard has two aspects: the dashboard viewer (used by dashboard users) and the dashboard designer (used by dashboard administrators).

Generally, you access dashboards and SAS BI Dashboard from a SAS BI Dashboard portlet within the SAS Information Delivery Portal. (For more information, see Chapter 3, “Getting Started: The SAS Information Delivery Portal,” on page 9.)

Your role (dashboard user or dashboard administrator) determines the functions that are available to you.

You can also start the dashboard viewer directly by using this URL within your browser:


Dashboard Users
As a dashboard user, you work with dashboards in the SAS BI Dashboard portlet.
For more information about the SAS BI Dashboard portlet and selecting a dashboard, see Chapter 4, “Working with the SAS BI Dashboard Portlet,” on page 15.

You can also click (in the upper right corner of a dashboard) to work with dashboards in the dashboard viewer, which opens in a separate window.

Note: You might need to horizontally scroll within the SAS BI Dashboard portlet to see the icon.

The dashboard viewer opens and displays the dashboard that was displayed in the SAS BI Dashboard portlet.
The dashboard viewer enables enhanced functionality. For more information, see Chapter 5, “Working with Dashboards and Indicators in the Dashboard Viewer,” on page 17.

**Dashboard Administrators**

As a dashboard administrator, you manage dashboards in the dashboard designer of the SAS BI Dashboard. To start the dashboard designer, click in a dashboard in a SAS BI Dashboard portlet, or click **Manage Dashboards** when displaying dashboards in the dashboard viewer.

When you start the dashboard designer using either of the previous methods while viewing a dashboard, the same dashboard is displayed in the dashboard designer so that you can quickly modify it.
When you start the dashboard designer using either of the previous methods while not viewing a dashboard, a default page is displayed in the dashboard designer.

For more information, see Chapter 6, “The Dashboard Designer Window,” on page 27.
Chapter 3
Getting Started: The SAS Information Delivery Portal

Overview

The SAS BI Dashboard can be accessed from within the SAS Information Delivery Portal. This guide assumes that you are familiar with the SAS Information Delivery Portal. If you are not, see the online Help.

Open the Portal and Log On

To open the SAS Information Delivery Portal:

1. Open your Web browser and point it to the portal's URL address.
   
   To obtain the URL, contact your portal administrator.

2. To identify yourself to the portal, log on with your user name and password.
   
   If you do not have a user name and password, contact your system administrator to obtain them.
   
   The logon procedure varies depending on how your organization has installed the portal. Use either the portal logon procedure or the Web server logon procedure, as appropriate.

3. If your organization uses the portal's logon feature, do the following:
   
   a. Open your browser and point to the portal's URL.
   
      Either a public page or the portal's logon page appears.
   
   b. If a public page appears, click Log On in the banner.
   
   c. On the logon page, enter your user name and password.
   
   d. Click Log On.
4. If your organization uses a Web server to identify each user, do the following:
   a. Use the Web server logon procedure specified for your organization.
      The Web server logon procedure is different in each organization.
   b. After you have logged on to the Web server, point your browser to the portal's URL.
      Your personal portal opens.

Create a Page and Add It to Your Navigation Bar

To create a new page and add it to your navigation bar:

1. Click **Customize ⇒ Add Page**.
   The Add Pages to Profile page appears.

2. On the **Create** tab, enter descriptive information about the page:
   
   **Name**
   is a short name that appears in the page's tab in the navigation bar.

   **Description**
   is a short description that appears with the page title in search results.

   **Keywords**
   are single words that you or other users can use to search for this page. Use spaces
to separate keywords from one another.

   **Note:** To ensure efficient searching, develop a standard list of keywords and use
these keywords consistently.

   **Page rank**
   is a number that indicates the importance of this page as compared to other pages.
The default value is 100.

   This number determines the order in which pages are listed in the navigation bar.
The pages are ordered by rank from lowest to highest. Pages with equal rank are
listed in the order in which they were created.
Note: You can choose to override page ranks by explicitly defining the order of pages.

**Location (group) and Share type**

are fields that appear only if you are a group content administrator. In these fields, you can specify a group with which the page is to be shared and specify the share type.

3. Click **Add**.

A message appears, indicating that a new page was added.

4. Click **Done**.

---

### Add a SAS BI Dashboard Portlet to a Page

To add a SAS BI Dashboard portlet to a page:

1. Navigate to the page that you want to add the portlet to.

2. Click **Customize ➔ Edit Page ➔ Edit Page Content**.

The Edit Page Content page appears.

3. Click **Add Portlets**.

The Add Portlets to Page page appears.

3. Click **Add Portlets**.

The Add Portlets to Page page appears.
4. From the Portlet type drop-down list, select SAS BI Dashboard Portlet.
5. Type the name for the portlet and, if desired, the description and keywords.
6. If you are a group content administrator, select a group with which the portlet is to be shared from the Location (group) drop-down list.
7. Click Add, and then Done.
8. On the Edit Page Content page, click OK.
   The original page is displayed, with the new portlet added.
9. Select a dashboard or indicator.
   For more information, see “Select a Dashboard” on page 15.
Part 2

Information for Dashboard Users

Chapter 4  
*Working with the SAS BI Dashboard Portlet* .......................... 15

Chapter 5  
*Working with Dashboards and Indicators in the Dashboard Viewer* 17
Chapter 4
Working with the SAS BI Dashboard Portlet

Select a Dashboard

To select a dashboard:

1. Click 🏷.

   The Edit Portlet page appears.
2. From the tree, select a dashboard. This list includes dashboards created by your organization.

---

**Specify Display Options**

**Specify the Dashboard Dimensions**

To specify the dashboard dimensions:
1. Click .
   The Edit Portlet page appears.
2. Type values for the width and height.

**Refresh the Contents**

To manually refresh the contents of a SAS BI Dashboard portlet, click .
To automatically refresh the contents:
1. Click .
   The Edit Portlet page appears.
2. Next to **Auto refresh interval**, select the **Refresh every** check box, and then type a value in the box.

---

**Print a Dashboard or Indicator**

To print a dashboard, click in the upper right corner of the dashboard.
To print an indicator, select **Print Indicator** from the indicator's **Options menu**.
Chapter 5
Working with Dashboards and Indicators in the Dashboard Viewer

Overview
You can display a dashboard or indicator in the dashboard viewer rather than in the SAS Information Delivery Portal. Displaying a dashboard this way enables you to do the following:
• create a larger dashboard with numerous interactive indicators
• personalize alerts
• add comments to an indicator
• create favorites
For more information, see “The Workflow” on page 5.

Open a Dashboard or Indicator
To open a dashboard or indicator, select File → Open, and then navigate to the dashboard or indicator.
In addition to indicators, this list includes dashboards created by your organization.
Navigate in the Dashboard Viewer

After you open a second dashboard or indicator, the navigation controls appear below the menu bar.

These controls are also available when you select View ➔ Go To.

The navigation controls enable you to move backward and forward through the dashboards and indicators that you have opened. The down arrow (history list) enables you to select any opened dashboard or indicator, instead of moving through the opened items one at a time.

Display Options

The Default View

By default, the dashboard viewer displays the last dashboard or indicator that was displayed when the dashboard was closed. However, there might be times when you do not want to display this dashboard or indicator.

To display no dashboard or indicator when the SAS BI Dashboard is first started, clear the check box View ➔ Open the previously viewed dashboard by default.

Refresh the Contents

To manually refresh the contents of the dashboard viewer, click 🔄.

To automatically refresh the contents:

1. Select View ➔ Set the automatic refresh interval.

   The Refresh Interval dialog box appears.
2. Select the **Automatic refresh** check box, and then specify the time interval.

---

### Print a Dashboard or Indicator

To print a dashboard, click 📚 in the upper right corner of the dashboard.

To print an indicator, select **Print Indicator** from the **Options menu**.

---

### Create or Edit a Personal Indicator Alert

If a dashboard administrator has enabled personal alerts for an indicator, you can define a personal indicator alert on the indicator. A personal indicator alert is sent only to you. This is different from an indicator alert, which is sent to a list of one or more alert subscribers.

A personal alert is in addition to any alerts attached to an indicator that was created by a dashboard administrator.

*Note:* The alerts shown on this page are only your personal indicator alerts. Indicator alerts created by dashboard administrators are not shown.

To create or edit a personal indicator alert, from an indicator's **Options menu**, select **Personalize Alerts**.
Note: If Personalize Alerts is not available, then the dashboard administrator has not enabled personalization. If the Options menu is not available, the indicator is not being displayed in a tile. Contact the dashboard administrator. For information about tiles, see “Tiles” on page 33.

The Edit Indicator Alerts dialog box appears in a new window.

To create a personal indicator alert:

1. Click New Alert.
2. Type the name of the alert.
3. From the Gauge definition and Trigger interval drop-down lists, select the gauge definition and the interval to trigger the alert.
4. Choose when to trigger the alert: Any gauge is in the interval or % of gauges are in the interval.
5. If you chose % of gauges are in the interval, type a percentage in the field next to the check box.
6. Select the delivery method for the alert: Alerts portlet or E-mail subscribers.

Note: You can select both.
7. (Optional) If you selected **E-mail subscribers**:
   a. From the **E-mail template** drop-down list, select the e-mail template to use to format the e-mail.
      The items included in the list are controlled by the dashboard administrator.
   b. Type the subject line and additional message to include in the e-mail.

To edit an indicator alert:
1. From the **Alerts** table, select an alert.
   The properties of the alert appear on the left side of the dialog box.
2. Edit the properties.

To delete an alert, select one from the **Alerts** table, and then click **X**.

---

**Manage Comments**

To manage comments, select **Manage Comments** from an indicator's **Options menu**.

The Comments dialog box appears.
To start a new topic:

1. Click **New Topic**.

   The New Topic dialog box appears.

2. Type the topic name and comment.

3. To attach a file, click **Attachment**, and navigate to the file.

   To edit a comment, click 🔍, and then make changes to the comment.
To delete a comment, click \(\times\).

*Note:* Only users in the Comment Administrator role can edit and delete comments.

To reply to a comment, click **Reply**, and then type a comment.

To sort and filter the comments, select an option from the **Actions** menu.

---

**Work with Favorites**

To easily return to a dashboard or an indicator, you can add it to your favorites.

To add a dashboard to your favorites, select **Favorites ⇒ Add Dashboard to Favorites**.

To add an indicator to your favorites, select **Favorites ⇒ Add Indicator to Favorites ⇒ <Name of indicator>**.

To select a favorite, select one from the bottom area of the **Favorites** menu.

To manage your favorites:

1. Select **Favorites ⇒ Manage Favorites**.

   The Manage Favorites dialog box appears.

2. To create a folder in your favorites, click \(\text{Folder Image}\) and then name the folder.

3. To rename a favorite or folder, click the item's name, and then type the name.

4. To move a favorite or folder, drag the item.

   *Note:* To drag an item into a folder, first expand the folder, and then drag the item into the folder.

5. To delete a favorite or folder, click the item's name, and then click \(\times\).
Part 3

Information for Dashboard Administrators

Chapter 6
The Dashboard Designer Window ........................................... 27

Chapter 7
Indicator Data ................................................................. 37

Chapter 8
Ranges ............................................................................. 49

Chapter 9
Indicators ........................................................................... 53

Chapter 10
Dashboards .......................................................................... 105
Chapter 6
The Dashboard Designer Window

Overview

The dashboard designer window contains three areas (from left to right):

- the Objects pane (see “The Objects Pane” on page 28)
- the workspace (see “The Workspace” on page 32)
- the Properties pane (see “The Properties Pane” on page 34)
CAUTION:
Do not refresh the browser window. If you refresh the browser window, any unsaved dashboard content is lost.

The Objects Pane

The Library View

Overview
In addition to listing the dashboards, the Library view contains the objects that you combine to create a dashboard:

- indicator data (see Chapter 7, “Indicator Data,” on page 37)
- ranges (see Chapter 8, “Ranges,” on page 49)
- indicators (see Chapter 9, “Indicators,” on page 53)

It also contains additional objects to control the display of information within a dashboard and dashboards. For more information, see “The Layout Templates View” on page 32, “The Static Content View” on page 32, and Chapter 10, “Dashboards,” on page 105.

You create a new object by selecting the type of object from the New drop-down list.
The **Library** view contains a library tree in which you store the objects. To refresh the list, click ![refresh](image). To limit the library tree to display only a certain type of object, select the type of object from the **Show** drop-down list.

To search for a saved object:

1. Click ![search](image).
   
   The Search dialog box appears.
2. Type all or part of the object's name, and then choose whether to include object
descriptions and keywords in the search.

3. (Optional) Select the type of object.

4. Select the location, and then choose whether to include subfolders in the search.

5. (Optional) Specify the creation or last modified data, and then click the calendar icons
to specify the date range.

6. Click Search.

   Any objects that are found appear in the table to the right.

7. Select an object, and then click OK.

**Organizing the Folders in the Library Tree**

SAS BI Dashboard enables you to create folders and subfolders within the Library tree to
organize SAS BI Dashboard objects. This ability to organize SAS BI Dashboard objects
enables you to create folder structures that can be secured based on your business rules or
needs.

SAS recommends that you carefully consider how SAS BI Dashboard objects will be
stored, and then communicate that strategy to dashboard users.
One strategy is to create a folder for each department in your organization. Each department would then store their SAS BI Dashboard objects and other SAS objects (such as reports and information maps) within the folder. Within a department’s folder, you should consider how dashboard objects are related, and you should use a consistent folder structure that enables dashboard users to more easily understand how various objects are associated.

For example, you could create a folder structure like this for the Finance department:

```
Finance
  Dashboard_1
    Indicator_1
      Indicator_1.idx
      Indicator_Data_1.imx
      Range_1.rdx
    Indicator_2
      Indicator_2.idx
      Indicator_Data_2.imx
      Range_2.rdx
      Dashboard_1.docx
  Dashboard_2
    Indicator_3
      Indicator_3.idx
      Indicator_Data_3.imx
      Range_3.rdx
    Indicator_4
      Indicator_4.idx
      Indicator_Data_4.imx
      Range_4.rdx
      Dashboard_2.docx
```

A similar, and less complex, strategy is to create a folder for each type of SAS BI Dashboard object within each department:
The Layout Templates View

The **Layout Templates** view contains objects that control the flow of the indicators that are displayed in a dashboard.

The horizontal and vertical flow containers automatically flow (in the indicated direction) the indicators that they contain. Wrapping occurs when the indicators exceed the container's width or height.

The Static Content View

The **Static Content** view contains objects that display a label or an image. A label or an image can be a link. For more information, see “Manage Dashboard Contents” on page 114.

The Workspace

Overview

The workspace is the place where you interactively work with the objects that make up a dashboard. Each object is displayed on its own tab.
You can maximize the workspace by selecting View \(\Rightarrow\) **Maximize Workspace**. You return the workspace to its normal size by selecting View \(\Rightarrow\) **Expand Workspace Panels**.

**Tiles**

For a dashboard, which contains multiple objects, each object is displayed in a tile. When you move the mouse pointer over the tile, sizing handles appear around the tile's borders and a toolbar appears at the top left of the tile.

*Note:* A dashboard administrator can choose to display an indicator without the tile.

**Editing an Object**

To access the toolbar for an object, hover over the tile.

The toolbar buttons perform these actions:

<table>
<thead>
<tr>
<th>Button</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>(\times)</td>
<td>Deletes the object.</td>
</tr>
<tr>
<td></td>
<td>Displays the object's properties.</td>
</tr>
<tr>
<td></td>
<td>Displays the indicator data properties. This button is available for indicators only.</td>
</tr>
</tbody>
</table>
Displays the range properties. This button is available for indicators only.

When you edit the contents of a flow container, the Edit Flow Container dialog box appears. From here you remove the objects within the container by moving the objects from the Selected items list to the Available items list.

To edit the dimensions of an object within a flow container, select the object from the Selected items list, and then edit the properties in the Properties area.

For more information about the flow containers, see “The Layout Templates View” on page 32.

**Manipulating Objects**

To resize an object, drag the sizing handles that appear around the object's tile. You can also edit the width and height in the Properties pane.

To move an object, drag the border of the object. You can also edit the left and top positions in the Properties pane.

**The Properties Pane**

The Properties pane displays the properties for the selected object.
However, indicator data and ranges do not display their properties in the **Properties** pane. All of their properties are displayed on their tab.
Chapter 7
Indicator Data

Overview

The SAS BI Dashboard indicator data object associates a data source with an indicator. The core object is the indicator, and a dashboard is just a collection of indicators. An indicator never has more than one set of indicator data (and is rarely used without indicator data). Access to four types of data sources is supplied with the SAS BI Dashboard:

- SQL queries, which can access relational data
- information maps, which can access relational data and OLAP cubes
- tables, which can access data in a SAS data set that is registered in SAS metadata
- stored processes, which can access various types of data

Note: The SAS BI Dashboard administrator can add access to other data sources.

Before you create a dashboard, you must understand how to create indicator data. Understanding the data flow in the SAS BI Dashboard is the key to building enterprise dashboards that operate efficiently within your organization’s business intelligence system.

Unlike the flow of data in a report (which is usually relatively simple), the flow of data in a dashboard can be very different. Consider the dashboard in your car. Although you see a single representation of the state of the car, the state is actually a collection of different types of data received by the dashboard. The fuel gauge receives data from the fuel tank, the speedometer receives data from the wheels, the battery gauge receives data from the
battery, and so on. Like your car’s dashboard, a SAS BI Dashboard can have disparate data sources.

Whereas a report created with SAS Web Report Studio might fill several screens with data from a single information map, a dashboard might render data in a small display that is the result of SQL and JDBC queries and information maps. A dashboard can also render the output of stored processes that produce static images.

By using information maps and SQL queries to retrieve data, you are unconstrained with how the data is laid out at the data set level. For example, you can use computed columns and grouping in the indicator data. After you have the data configured, the lack of constraints helps you to get initial dashboards set up quickly. But this same simplicity means that data structure is not enforced.

---

**Indicator Data Rules**

Here are several rules to help you to create quicker and more efficient indicator data:

- **Plan the indicator data by considering the indicator display types that will be used with the indicator data and the required appearance of the desired end result.**

  For example, KPIs appear best with indicator data that produces summarized data with a limited number of data rows. Indicator data with significant amounts of data, when used to drive a KPI indicator display, causes the SAS BI Dashboard to try to produce one KPI graphic representation for each row of data in the indicator data. Other indicator display types, such as the bar chart, automatically summarize the data. In this case, it might be appropriate to use indicator data that produces a larger number of data rows.

- **To display a single gauge in an indicator, the indicator data must return a single row of data.**

- **Create indicator data so that it executes quickly.**

  A single slow set of indicator data will slow the entire dashboard. Even when indicator data returns only a single row of data, if it must first join tables that each contain thousands of rows of data, the indicator data will not perform well.

- **If the source data has too many rows, summarize the data.**

  Summarize data at the indicator data or data-model level. Do not rely on the indicator display to perform the summary.

  For an SQL query, you can summarize data using aggregation functions such as AVG() and the distinct keyword.

  Another summarization strategy is to summarize the data into a summary table. The summary table is then used as the basis for the SQL query or as the base table for the information map. The first illustration that follows shows the SAS BI Dashboard indicator data using a query that combines data from multiple tables. The second illustration shows the same two tables being summarized by an ETL program. The SAS BI Dashboard indicator data then uses this summarized table.
The first method is easier to set up and might result in more timely data, but the second method is more flexible and will probably be more scalable. You can use a similar strategy when creating information maps that will be used by the SAS BI Dashboard indicator data.

- To display multiple gauges or a graph in an indicator, each numeric value should be associated with a descriptive name.

After you define indicator data, you select the data fields to include in the indicator display. For every numeric data field displayed in the indicator, you can select a data field from the Category Label drop-down list to associate with the numeric value. This associated data field is displayed with the gauge or the category value in a graph.

### Stored Process Indicator Data

Use these general steps to create a SAS stored process for use with SAS BI Dashboard:

1. Write the code for the stored process that does these things:
   a. Creates a SAS data set in the SAS Work library
   b. Publishes the data to a SAS Package file using the SAS Publishing Framework
   c. Sets the macro variable _ARCHIVE_FULLPATH to the path of the archive file that the stored process generates

2. In SAS Management Console, register the stored process in the SAS metadata, designate it as creating a package, and then specify the target data.

   For more information about how to specify the target data, see the SAS Management Console online Help.

3. Save the stored process metadata registration.
The stored process is now ready to use in indicator data.

See Also

- “Define a Stored Process Data Source” on page 45
- “Custom Graph Display” on page 67

Defining Indicator Data

Data Columns

When you define indicator data, part of the information that you specify is the display attributes for each data column that is retrieved.

When you define an SQL query data source, you create a query that retrieves data from the data source. After you create the query, you submit the query for validation.

If the query is incorrect, the list is empty, and an error message is displayed.

Here is an explanation of the fields:

**Column Name**

is the name of the data column. You cannot modify this value.

In each type of display, **Column Name** is used as the default value for the names of the **Category Label**, **Label**, and **Property Alias**.

**Category Label**

is the data column that contains the name that is displayed on a KPI gauge or graph.

**Label**

is the data column that contains the formatted value that is displayed. This format can be a simple numeric value of a label.

An SQL query does not require this field. To create a formatted label at the bottom of a gauge, create the label as a formatted string in the SQL query, and then define that formatted string as the **Label** attribute.

Here is how **Label** appears in each type of display:

<table>
<thead>
<tr>
<th>Display Type</th>
<th>Appearance of Label</th>
</tr>
</thead>
<tbody>
<tr>
<td>All graphical displays</td>
<td>Displayed below each gauge and in tooltip text (to the right of the colon). For line and bar charts, displayed as the category for a given value.</td>
</tr>
<tr>
<td>Custom graph</td>
<td>Not used.</td>
</tr>
<tr>
<td>Dynamic prompt</td>
<td>Displayed in tooltip text.</td>
</tr>
<tr>
<td>Dynamic text</td>
<td>Not used.</td>
</tr>
<tr>
<td>KPI</td>
<td>Displayed below each gauge.</td>
</tr>
<tr>
<td>Spark table</td>
<td>Displayed in the value column.</td>
</tr>
</tbody>
</table>
**Hyperlink**
is the data column that contains hyperlinks.

In each type of display, hyperlinks are embedded in gauges or individual data points in graphs.

**Property Alias**
is the text that replaces the value retrieved for Label.

Here is how Property Alias appears in each type of display:

<table>
<thead>
<tr>
<th>Display Type</th>
<th>Appearance of Property Alias</th>
</tr>
</thead>
<tbody>
<tr>
<td>All graphical displays</td>
<td>Displayed as the axis label and in tooltip text (to the left of the colon).</td>
</tr>
<tr>
<td>Custom graph</td>
<td>Not used.</td>
</tr>
<tr>
<td>Dynamic prompt</td>
<td>Displayed in tooltip text.</td>
</tr>
<tr>
<td>Dynamic text</td>
<td>Not used.</td>
</tr>
<tr>
<td>KPI</td>
<td>Displayed as the axis label and in tooltip text (to the left of the colon).</td>
</tr>
<tr>
<td>Spark table</td>
<td>Displayed as the column heading.</td>
</tr>
</tbody>
</table>

---

**Information Map Data Source**

**Overview**
An information map data source easily aggregates data in such a flexible manner that a single information map can drive several different dashboard indicators.

**OLAP Information Maps**
The data returned from an OLAP information map is flattened into a two-dimensional table structure. You assign a role for each dimension when you define the data source. The roles are Column, Row, and Slicer.

*Note:* You must assign the role of Row to at least one data column.

For dimensions with the role of Row, the levels of each hierarchy are the data fields. The corresponding members of the level are the values of the data field, where the field name is the label for the level. The other data fields are the columns that are typically seen in an OLAP viewer. The field names for the data fields are the comma-delimited levels of the dimensions with the role of Column, in the order of the dimensions with the role of Row.

You can use the grouping feature of the bar chart with reference lines display with an OLAP information map to create a multi-dimensional display of data.
Create or Edit Indicator Data

Start to Create or Edit Indicator Data

To create or edit indicator data:

*Note:* You can also create or edit indicator data when you create or edit an indicator. For more information, see “Create or Edit an Indicator” on page 54.

1. In a dashboard portlet, click **Manage Dashboards**.
   
The SAS BI Dashboard appears in a new browser tab.

2. To create indicator data:
   
   a. In the **Library** view of the **Objects** pane, select **Indicator Data** from the **New** drop-down list.
      
The Create Indicator Data dialog box appears.

   b. Type the name, and then click **OK**.

3. To edit indicator data, in the **Library** view of the **Objects** pane, navigate to a location that contains indicator data, and then double-click the name.

   *Note:* You can choose to display only indicator data in the library tree by selecting **Indicator data** from the **Show** drop-down list.
4. Define a data source.
   For more information, see one of the following, and then return to this task:
   • “Define an Information Map Data Source” on page 43
   • “Define an SQL Query Data Source” on page 44
   • “Define a Table Data Source” on page 46
   • “Define a Stored Process Data Source” on page 45

5. To associate a data point property with data columns in the data source, do the following for each data point property:
   a. From the Column Name column, select the check box next to each data point property that you want to include in the display.
   b. From the Category Label drop-down list, select a data column in the data source that contains the category label or group variable.
      If the data source contains a Name data column, this data column is selected automatically for all data point properties.
   c. From the Label drop-down list, select a data column in the data source that contains the label for the data point property.
      If you need a complicated label, such as one that concatenates data fields and static text, create a data column in the data source to store the concatenation. Then type the name to display for the data point property in the Property Alias field.
   d. From the Hyperlink drop-down list, select a data column in the data source that contains the hyperlink for the data point property.
   e. In the Property Alias field, type the name to display for the data point property in the column heading in the KPI table display.
      Note: The KPI display ignores this value.

Define an Information Map Data Source

CAUTION:
The maximum number of rows returned by a relational information map data source is 1,000. If the source data contains more than 1,000 rows, the information shown by an indicator that uses the relational information map data source is probably wrong. If possible, aggregate the data to reduce the number of rows to return.

To define an information map data source:
1. Perform the first three steps of the task “Start to Create or Edit Indicator Data” on page 42.
2. From the Data source drop-down list, select Information map.
   The fields to define an information map data source appear.
3. Next to the **Information map** field, click **Browse**.
   The Open dialog box appears.

4. Navigate to an information map, select it, and then click **Open**.

5. Move data columns and filters between the **Available items** list and the **Selected items** list by selecting one or more items and clicking the arrows between the lists.
   A filter is moved under the **Filters** node. By default, a data column is moved under the **Column** node. If the information map is based on an OLAP cube, the **Selected item** list includes the nodes **Row** and **Slicer**. To use a data column in either of these roles, select **Row** or **Slicer** before moving the data column from the **Available** list.
   **Note:** To make available a filter that contains a user prompt, the prompt must have a default value specified in SAS Information Map Studio.

6. To move a data column between groups, click the name of a data column in the **Selected items** list, and then move it up or down by clicking one of the arrows that are next to the list.

7. When the data columns are set, click **Apply Query Changes**.

8. To view the data that is included in the indicator data, click the **Query Results** tab.

9. Continue with step 5 of the task “Create or Edit Indicator Data” on page 42.

### Define an SQL Query Data Source

To define an SQL query data source:

1. Perform the first three steps of the task “Start to Create or Edit Indicator Data” on page 42.

2. From the **Data source** drop-down list, select **SQL query**.
   The fields to define an SQL query data source appear.
3. In the **Query** field, type the query code.

4. Click **Submit**.

5. To view the data that is included in the indicator data, click the **Query Results** tab.

6. Continue with step 5 of the task “Create or Edit Indicator Data” on page 42.

**Define a Stored Process Data Source**

To define a stored process data source:

1. Perform the first three steps of the task “Start to Create or Edit Indicator Data” on page 42.

2. From the **Data source** drop-down list, select **Stored process**.

   The fields to define a stored process data source appear.
3. Next to the Stored process field, click Browse.
   
   The Open dialog box appears.

4. Navigate to a stored process, select it, and then click Open.

5. From the Published data set name drop-down list, select a data set.

6. (Optional) Choose to have the SAS log added to the server log.
   
   Selecting this option enables you to review this information later.

7. Click Apply Changes.

8. To view the data that is included in the indicator data, click the Query Results tab.

9. Continue with step 5 of the task “Create or Edit Indicator Data” on page 42.

See Also
“Stored Process Indicator Data” on page 39

Define a Table Data Source

CAUTION:
The maximum number of rows returned by a table data source is 1,000. If the source data contains more than 1,000 rows, the information shown by an indicator that uses the table data source is probably wrong. If possible, aggregate the data to reduce the number of rows to return.

To define a table data source:

1. Perform the first three steps of the task “Start to Create or Edit Indicator Data” on page 42.

2. From the Data source drop-down list, select Table.
   
   The fields to define a table data source appear.
3. From the Table tree, select a table.
   
   The data columns in the table appear in the Available columns table.

4. From the Available columns table, select the data columns to include in the indicator data by selecting the check box at the end of a row.

5. For each selected data column, select a method to summarize the data from the Summary column.

6. For each selected data column, choose whether to group the data by selecting the check box in the Group By column.

7. To specify additional filters, type the filter (using SQL syntax) into the Filters field.
   
   Note: Do not type the key word where. This causes an error because where is automatically supplied.

8. Click Apply Query Changes.

9. To view the data that is included in the indicator data, click the Query Results tab.

10. Continue with step 5 of the task “Create or Edit Indicator Data” on page 42.
Create or Edit a Range

Start to Create or Edit a Range

Define the Range

Create or Edit a Range

Start to Create or Edit a Range

A range defines the measurement intervals by which a metric is evaluated, such as below target, on target, and above target.

To create or edit a range:

1. In a dashboard portlet, click Manage Dashboards.

The SAS BI Dashboard appears in a new browser tab.

2. To create a range:

   a. In the Library view of the Objects pane, select Range from the New drop-down list.
The Create a Range dialog box appears.

b. Type the name, and then click OK.

3. To edit a range, in the Library view of the Objects pane, navigate to a location that contains a range, and then double-click the name.

   *Note:* You can choose to display only ranges in the library tree by selecting Range from the Show drop-down list.

---

**Define the Range**

To define the range:

1. If needed, type a description.

2. For each interval in the range, click Add Interval, type the interval value in the Upper bound field, and then click OK.

   The interval is added to the table of intervals. You can add the values in any order; the software orders them correctly in the table.

   *Note:* Valid input includes a sign, digits, and a locale-dependent decimal separator.
3. To define each interval:
   a. For a static gauge, in the **Code Interval** column, select a code interval from the drop-down list. The available intervals depend on the gauge.
   b. In the **Relation** column, select an operator from the drop-down list, and specify a value in the adjacent **Lower Value** column.
   c. In the **Label** column, type the label.
   d. Click in the **Color** column and select a color.
   e. To delete an interval, click ✗ next to the interval.
   f. To preview how the range will appear, select a gauge type from the **Dynamic gauge type** drop-down list.

You can control which users can use the range. For more information, see the SAS Management Console online Help.
Overview

An indicator includes a title and a display. The display includes one or more data values, a hyperlink (optional), and one or more gauges, a graph, or an image. Here is an example of a KPI indicator:

The indicator title is Regional Sales KPIs. The names of the gauges, such as NW and NYC, are the values of the data column specified by the Category Label field when the data source was defined. The values, such as 10% and 35%, are the values of the data column specified by the Label field. The hyperlink is not shown. For more information about where these items of information appear in each type of display, see “Defining Indicator Data” on page 40.

You select the display when you create or edit an indicator. For more information, see “Create or Edit an Indicator” on page 54 and “Indicator Displays” on page 59.

Create or Edit an Indicator

Overview

There are six general steps to create or edit an indicator:

1. Start to create or edit an indicator. (See page 54.)
2. Define the general properties. (See page 56.)
3. Define the role-mapping properties. (See page 56.)
4. Define the user personalization properties. (See page 57.)
5. Set up the links. (See page 57.)
6. Create or edit an indicator alert. (See page 58.)

When you edit an indicator, you can perform any of the steps in any order.

Start to Create or Edit an Indicator

To start to create or edit an indicator:

1. Click Manage Dashboards.

   The dashboard designer appears.
2. To create an indicator:
   a. In the **Library** view of the **Objects** pane, select **Indicator** from the **New** drop-down list.
      
The Create an Indicator dialog box appears.

![Create an Indicator](image)

b. Type the name.

c. Select the display type.
   
   Other controls might appear below the **Indicator data** field, based on the display type that you select.

d. To select existing indicator data, click **Browse** next to the **Indicator data** field, navigate to the indicator data, and then open it.

e. To create indicator data, click **New** next to the **Indicator data** field.
   
   For more information, see step 2 of the task “Start to Create or Edit Indicator Data” on page 42.

f. Click **OK**.

3. To edit an indicator, in the **Library** view of the **Objects** pane, navigate to a location that contains an indicator, and then double-click the name.

   **Note:** You can choose to display only indicators in the library tree by selecting **Indicator** from the **Show** drop-down list.
**Define the General Properties**

1. Change the height and width by specifying values in the controls or by clicking the indicator and dragging the resize handles.
   
   The height and width values are in intervals of five pixels.
   
   *Note:* For an interactive summary chart and detail chart display or an interactive summary chart and detail plot display, the minimum legible dimensions are 380 x 450 pixels.
   
   These height and width settings apply only when the indicator is displayed by itself, not on a dashboard. When displayed on a dashboard, the indicator's height and width are specified in the **Object** area of the **Properties** pane.

2. Select the display type.
   
   Other controls might appear, based on the display type that you select.
   
   For information about gauges, see “Select a Gauge for an Indicator” on page 102.

3. To select existing indicator data, click **Browse** next to the **Indicator data** field, navigate to the indicator data, and then open it.
   
   *Note:* You interact with range data, if available, in the same manner as the indicator data.

4. To create indicator data, click **New** next to the **Indicator data** field.
   
   For more information, see step 2 of the task “Start to Create or Edit Indicator Data” on page 42.

5. To use existing indicator data, click **Browse**, navigate to the indicator data, and then double-click the name.

6. To edit the indicator data, click **Edit**.
   
   For more information, see one of the following:
   
   - “Define an Information Map Data Source” on page 43
   - “Define an SQL Query Data Source” on page 44
   - “Define a Table Data Source” on page 46
   - “Define a Stored Process Data Source” on page 45

7. To create indicator data, click **New** next to the **Indicator data** field.
   
   For more information, see step 2 of the task “Start to Create or Edit Indicator Data” on page 42.

8. (Optional) Choose how to sort the displayed data.

**Define the Role-Mapping Properties**

The role-mapping properties determine which data is included in the display, how the data is grouped, how the data is summarized, and so on.

The role-mapping properties that are available depend on the type of display that you select.

For a list of the role-mapping properties, see Appendix A1, “Indicator Role-Mapping Properties,” on page 121.
Define the User Personalization Properties

(Optional) Choose whether to allow users to manage alerts and whether to limit which e-mail templates the user can select.

Set Up the Links

1. Click at the top of the Properties pane.

The Set Up Link dialog box appears.

![Set Up Link dialog box](image)

*Note:* You cannot set up links for these indicator display types: chart with slider prompt, dynamic prompt, and dynamic text.

2. From the **Link type** drop-down list, select the type of link.
3. From the **Link target** drop-down list, select a window in which to open the link target.
4. If you selected an external link, type the URL of the link in the **Link** field.
5. If you selected a type other than an external link, click **Browse** next to the **Link** field, and then select an item.

The available choices depend on the type of link.

6. (Optional) To specify the parameters for the URL specified in the **Link** field that supports parameters:
   a. Click +.

   The **Name** and **Data point lookup** controls appear.

   *Note:* If you select **Web Report** for the link type, the **Name** column is renamed **Displayed Text**.

   b. Type the name of the parameter, and then select the data point lookup associated with the parameter.

   The name must match the expected name exactly, including case.

   The data point lookup is the data column that contains the parameter values.
c. Add as many parameters as needed.
d. To delete a parameter, select a row and then click \(\times\) next to the row.
e. To order the parameters, select a parameter, and then click the arrow buttons next to the parameter table.

**Create or Edit an Indicator Alert**

**Overview**
To create an indicator alert, click \(\text{add} \) at the top of the Properties pane.

*Note:* The trigger interval for an indicator alert depends on a range. Therefore, you can create an indicator alert only for an indicator that uses a display type that supports a range.

The Edit Indicator Alerts dialog box appears.

To create an indicator alert:

1. Click **New Alert**.
2. Type the name of the alert.
3. From the **Gauge definition** and **Trigger interval** drop-down lists, select the gauge definition and the interval to trigger the alert.
4. Choose when to trigger the alert: **Any gauge is in the interval** or **% of gauges are in the interval**.
5. If you chose **% of gauges are in the interval**, type a percentage in the field next to the check box.
6. Select the delivery method for the alert: **Alerts portlet** or **E-mail subscribers**.

*Note:* You can select both.
7. (Optional) If you selected **E-mail subscribers**:
   a. From the **E-mail template** drop-down list, select the e-mail template to use to format the e-mail.
   b. Type the subject and additional message to include in the e-mail.
   c. Click + next to the list of alert subscribers, and then select users and user groups.
      For more information, see “Add Users and User Groups,” which follows.
   d. To remove a subscriber, select one from the list, and then click X.

   **Add Users and User Groups**
   
   e. Type the text to search for in the **Search** field.
      Partial text is valid. Wildcards are not supported.
   f. Select the category (or both categories) to search.
   g. Click **Search**.
      A table appears with all entries that match the search criteria.
   h. From the table, select the check box next to each entry that you want to add.
      
      *Note:* You can also drag an entry from the table into the **List of alert subscribers**.

8. To limit the number of alerts, select the **Limit alerts on frequently changing indicators** check box, type a value, and then select a time interval.

   To edit an indicator alert:
   1. From the **Alerts** table, select an alert.
      The properties of the alert appear on the left side of the dialog box.
   2. Edit the properties.

   To delete an alert, select one from the **Alerts** table, and then click X.

---

**Indicator Displays**

**Bar Chart with Bullet Display**

Here is an example of a bar chart with bullet display:
Here are the properties that created the display:
Bar Chart with Reference Lines Display

The bar chart with reference lines display applies a range to a standard graph display such as bar chart or line graph. Here is an example of a bar chart with reference lines display:
Here are the properties that created the display:
For the best results, the indicator data should return only one value for each unique value in the **Category Label** data column. If the indicator data returns only one value, the bar chart with reference lines display does not need to aggregate the data. The category variable is specified by the data column selected for the **Category Label** field when the data source is defined.

If the bar chart with reference lines display does aggregate data, the bar chart with reference lines displays data points at the average interval for each data series. The indexes of the aggregated intervals are averaged to determine the interval to display and the color of the bar.

If the bar chart with reference lines display does aggregate data, the bar chart with reference lines does two things:

1. It displays data points at the average interval for each data series.
2. It averages the indexes of the aggregated intervals to determine the interval to display and the color of the bar.

Here are some guidelines for using the bar chart with reference lines display:

- To display the average interval in a graph, the bar chart with reference lines is the easiest method to use.
- The tooltip for each data series indicates that the displayed value is the average interval.
- To prevent aggregation by the bar chart with reference lines display, aggregate the data at the indicator data level.

**Bubble Plot Display**

Here is an example of a bubble plot display:

Here are the properties that created the display:
Chart with Slider Prompt Display

Here is an example of a chart with slider prompt display:
Here are the properties that created the display:

**Clustered Bar Chart Display**

Here is an example of a clustered bar chart display:

Here are the properties that created the display:
Custom Graph Display

Overview

The custom graph display presents information from a variety of sources. The visual representation is an image. The output of the graph display is specified by an external URL.

When you specify an image in the URL, you have the choice of using a proxy.

- If you do not choose to use a proxy, the image file must be in the same network domain as the SAS BI Dashboard server.

  Note: You can allow Adobe Flash to load images from other domains by creating a cross-domain policy file in the root of the Web server. For more information, search the Adobe Web site for “cross-domain policy file specification.”

- If you do choose to use a proxy, the image file must be accessible to the SAS middle tier. Ensure that the SAS middle tier has the proper user credentials to access the URL.

For more information, see “Use proxy” on page 130.

Here is an example of a custom graph display:
Here are the properties that created the display:

**Stored Processes**

You can use a stored process with a custom graph display to produce a graphical display that is not possible with the SAS BI Dashboard itself. To use a stored process, you must
create a stored process that is appropriate for inclusion in a dashboard and then derive the URL that renders the stored process output.

Use these guidelines to create a stored process:

• The output for the stored process must be set to streaming.
• The output should be small in size, perhaps no more than 300 X 300 pixels.

Conserving space in a dashboard is important so that dashboard users can get a broad overview of disparate metrics. Although a stored process that renders a graph might look good when it uses most of the window, the graph will displace all other information in the dashboard. If you cannot communicate the data in a small amount of space and users need to see other data in the same dashboard, consider using aggregation or another technique to reduce the amount of data that the stored process renders. Consider modifying the stored process in SAS Enterprise Guide to suppress the title and footnotes, and use the minimal template for output.

To determine the URL for a stored process, use the Stored Process Web application.

Choose to use a proxy so that the proxy server detects from the URL that the target is a stored process request. The proxy server then adds authentication for the current user to the middle tier.

**Dual Line Chart Display**

Here is an example of a dual line chart display:

![Example Dual Line Chart](image)

Here are the properties that created the display:
**Dynamic Prompt Display**

Here is an example of a dynamic prompt display:

```
EarthquakesPrompt
```

2001

Here are the properties that created the display:
CAUTION:
Ensure that each menu value is unique. Duplicate menu values cause unexpected behavior.

If you select Combo box with gauge for the prompt type, then you must select a range. If you select Combo box for the prompt type, then you cannot select a range.

Dynamic Text Display

Here is an example of a dynamic text display:

<table>
<thead>
<tr>
<th>EarthquakesText</th>
</tr>
</thead>
<tbody>
<tr>
<td>The worst earthquake is: 9</td>
</tr>
</tbody>
</table>

Here are the properties that created the display:
With the dynamic text display, a range is optional. If you select a range, the range value's text is colored based on the range interval colors.

**Forecast Chart Display**

Here is an example of a forecast chart display:

![Sales Forecast Chart](image)

Here are the properties that created the display:
Interactive Displays

Overview
The interactive displays enable dashboard users to interactively traverse large amounts of detail data by sliding along a summary chart. Detail data can be easily compared using two methods. In the first method, a column by which to group data is selected when the display is defined. In the second method, the user selects different detail slices to compare while viewing the display.

The interactive displays are as follows:

• the interactive summary and bar chart display
• the interactive summary and scatter plot display
• the interactive summary and targeted bar chart display

Setting up an interactive display is nearly identical to setting up a bar chart with reference lines display. However, an interactive display has more options and uses data in a more sophisticated way than the bar chart with reference lines display.
For the best results using the interactive displays, the indicator data must meet these requirements:

- The indicator data must be suitable for a bar chart with reference lines.
  Indicator data that returns a single row and that is suitable for a KPI display is not suitable for an interactive display.

- The indicator data must contain one low-cardinality grouping column that is used to summarize the data.
  A low-cardinality grouping column is a column that has a small number of unique values to group by.

- (Optional) To enable an interactive display to express forecasting data to business users, the indicator data must contain a column for forecasted values, for lower confidence values, and for upper confidence values.

An interactive bar chart display can summarize either the detail data expressed in the detail charts or can summarize a different field of data.

At the indicator level, the setup of the interactive displays is essentially the same as for other bar chart with reference lines, except that the use of data for the interactive displays is more sophisticated. The only significant difference is that the interactive displays support the concept of dependent ranges. A dependent range takes the value of another range for the range definition. This scheme enables a data set generated by the SAS Forecast Server to be useful to the SAS BI Dashboard and the interactive displays without the need for complicated intermediary data transformations.

**Interactive Summary and Bar Chart Display**

Here is an example of an interactive summary and bar chart display:
Here are the properties that created the display:

**Interactive Summary and Scatter Plot Display**

Here is an example of an interactive summary and scatter plot display:

Here are the properties that created the display:
Interactive Summary and Targeted Bar Chart Display

Here is an example of an interactive summary and targeted bar chart display:
Here are the properties that created the display:

**KPI Display**

**Overview**

The KPI display shows a single KPI or multiple KPIs. For a single KPI, the display shows the KPI associated with a single data value.

Here is an example of a KPI display:
Here are the properties that created the display:
For multiple KPIs, the display shows one KPI for each data point that is in scope. For the best results, aggregate related KPIs through a single set of indicator data so that a single indicator configuration controls the display of all values.

**Dynamic Gauges**

In addition to the static gauges that are displayed in the software, you can choose a gauge that is dynamic. A dynamic gauge is drawn by the software based on the type of gauge and the data values in the gauge.

Here are examples of the dynamic gauges:

- Dynamic bullet bar (horizontal and vertical)

  Canada
- Dynamic dial

[Image of a dynamic dial with Canada and percentages]

- Dynamic slider (horizontal and vertical)

[Image of a dynamic slider with Canada and percentages]

- Dynamic speedometer

[Image of a dynamic speedometer with Canada and percentages]

- Dynamic traffic light (horizontal and vertical)

[Image of a dynamic traffic light with Canada and percentages]
• Dynamic thermometer (horizontal and vertical)

![Dynamic thermometer](image)

• Radial thermometer

![Radial thermometer](image)

**Line Chart with Reference Lines Display**

Here is an example of a line chart with reference lines display:

![Line chart with reference lines](image)
Here are the properties that created the display:
**Needle Plot Display**

Here is an example of a needle plot display:

Here are the properties that created the display:

![Indicator Display](image)

- **Indicator**
  - **General**
    - Width: 700
    - Height: 400
    - Display: Needle Plot
  - **Indicator Data**
    - Name: [Browse]
  - **Sort Settings**
    - Sort by: [None]
    - Sort order: Ascending

- **Role Mapping**
  - X axis value: [date]
  - Y axis value: [Magnitude]
  - X axis title
  - Y axis title
  - Scale X axis
  - Scale Y axis
  - X axis format: [None]
  - Y axis format: [None]
  - X axis labels: None
Pie Chart Display

Here is an example of a pie chart display:

Here are the properties that created the display:

![Pie Chart Properties](image)
Range Map Display

The range map display shows graphs with results plotted on color-coded backgrounds that are based on range definitions.

Here is an example of a range map display:
Here are the properties that created the display:
**Scatter Histogram Display**

Here is an example of a scatter histogram display:

Here are the properties that created the display:

### General
- **Width:** 700
- **Height:** 400
- **Display:** Scatter Histogram

#### Indicator Data
- **Name:** <Users>/sasdemo/My Folder/Docs

#### Sort Settings
- **Sort by:** 
- **Sort order:** Ascending

### Role Mapping
- **X axis value:** year
- **Y axis value:** Magnitude

### Axes Titles
- **X axis title:**
- **Y axis title:**

- **Scale X axis**
- **Scale Y axis**
Scatter Plot Display

Here is an example of a scatter plot display:
Here are the properties that created the display:
Schedule Chart Display

Here is an example of a schedule chart display:

![Schedule Chart Display](image-url)
Here are the properties that created the display:

Simple Bar Chart Display

Here is an example of a simple bar chart display:
Here are the properties that created the display:

**Spark Table Display**

The spark table display shows data points in a table form, with one gauge per table row. The table column headings are the names of the data fields.

SAS suggests that all non-numeric data columns are removed from the indicator data.
Here is an example of a spark table display:

<table>
<thead>
<tr>
<th>Date</th>
<th>Lat</th>
<th>Lon</th>
<th>Depth</th>
<th>Stations</th>
<th>Comments</th>
<th>Magnitude</th>
</tr>
</thead>
<tbody>
<tr>
<td>13 Jan 2001</td>
<td>13.04</td>
<td>-88.86</td>
<td>60</td>
<td>427</td>
<td>EL SALVADOR, NW</td>
<td>7.7</td>
</tr>
<tr>
<td>26 Jan 2001</td>
<td>23.41</td>
<td>70.23</td>
<td>18</td>
<td>472</td>
<td>SOUTHERN INDIA, NW</td>
<td>7.7</td>
</tr>
<tr>
<td>23 Jun 2001</td>
<td>-15.26</td>
<td>-73.64</td>
<td>33</td>
<td>518</td>
<td>NEAR COAST OF PER</td>
<td>9.4</td>
</tr>
<tr>
<td>07 Jul 2001</td>
<td>-17.54</td>
<td>-72.07</td>
<td>33</td>
<td>368</td>
<td>NEAR COAST OF PER</td>
<td>7.6</td>
</tr>
<tr>
<td>14 Aug 2001</td>
<td>25.94</td>
<td>80.64</td>
<td>10</td>
<td>368</td>
<td>ONGHAI</td>
<td>7.8</td>
</tr>
<tr>
<td>18 Aug 2001</td>
<td>-21.18</td>
<td>-178.51</td>
<td>580</td>
<td>970</td>
<td>FJORD REGION, NW</td>
<td>7.7</td>
</tr>
<tr>
<td>08 Sep 2002</td>
<td>-3.8</td>
<td>142.94</td>
<td>13</td>
<td>428</td>
<td>NEAR NORTH COAST</td>
<td>7.6</td>
</tr>
<tr>
<td>10 Oct 2002</td>
<td>-1.75</td>
<td>134.29</td>
<td>10</td>
<td>375</td>
<td>NEAR THE NORTH CH</td>
<td>7.6</td>
</tr>
<tr>
<td>03 Nov 2002</td>
<td>63.51</td>
<td>-147.44</td>
<td>5</td>
<td>771</td>
<td>CENTRAL ALASKA, NE</td>
<td>7.8</td>
</tr>
<tr>
<td>22 Jan 2003</td>
<td>18.77</td>
<td>-104.4</td>
<td>24</td>
<td>551</td>
<td>OFFSHORE COLOMA</td>
<td>7.6</td>
</tr>
<tr>
<td>15 Jul 2003</td>
<td>-2.59</td>
<td>80.38</td>
<td>10</td>
<td>522</td>
<td>CARLSBERG RIDGE</td>
<td>7.6</td>
</tr>
<tr>
<td>04 Aug 2003</td>
<td>-60.53</td>
<td>-40.41</td>
<td>10</td>
<td>315</td>
<td>SOUTHERN SEA, NW</td>
<td>7.6</td>
</tr>
<tr>
<td>25 Sep 2003</td>
<td>41.91</td>
<td>143.91</td>
<td>27</td>
<td>868</td>
<td>HOKKAIDO</td>
<td>9.2</td>
</tr>
</tbody>
</table>

Here are the properties that created the display:

Note: To display the column properties, select a column in the data table.
If you have used SAS BI Dashboard in the past, the spark table display replaces the KPI table display and the bar and trend display.

**Stacked Bar Chart Display**

Here is an example of a stacked bar chart display:
Here are the properties that created the display:

- **Width:** 700
- **Height:** 400
- **Display:** Stacked Bar Chart
- **Graph style:** None
- **Indicator Data:**
  - **Name:** Users/assessment/MyFolderDocs
- **Sort Settings:**
  - **Sort by:** <None>
  - **Sort order:** Ascending
- **Role Mapping:**
  - **X axis value:** Year
  - **Stack group:** Month
  - **Y axis value:** Magnitude
  - **X axis title:**
  - **Y axis title:**
  - **Scale X axis:** checked
  - **Scale Y axis:** checked
  - **X axis format:** <None>
  - **Y axis format:** <None>
  - **X axis labels:** None
Targeted Bar Chart Display

Here is an example of a targeted bar chart display:
Here are the properties that created the display:

- **Indicator**
  - **General**
    - Width: 700
    - Height: 400
    - Display: Targeted Bar Chart
    - Graph style: None
  - **Indicator Data**
    - Name: [Details]
  - **Range**
    - Name: [Details]
  - **Sort Settings**
    - Sort by: None
    - Sort order: Ascending

- **Role Mapping**
  - Range Value: Magnitude
  - X axis value: Year
  - Bar value: Depth
  - Target value: Stations
  - X axis title: [Details]
  - Y axis title: [Details]
  - Scale X axis
  - Scale Y axis
  - Hide axis tick labels
  - Hide axes when zoomed out
  - Row group by: None
  - Column group by: None
  - Y axis format: [Details]
  - X axis format: [Details]
  - X axis labels: None
Tile Chart Display

Here is an example of a tile chart display:

Here are the properties that created the display:

- **Indicator**
  - **General**
    - Width: 700
    - Height: 400
    - Display: Tile Chart
    - Graph style: None
  - **Indicator Data**
    - Name: Users/xxdemo/My Folder/Docs
  - **Range**
    - Name: Users/xxdemo/My Folder/Docs
  - **Sort Settings**
    - Sort by: <None>
    - Sort order: Ascending

- **Role Mapping**
  - Range Value: Magnitude
  - Tile by: year
  - Tile size: depth
  - Show labels
Vector Plot Display

Here is an example of a vector plot display:
Here are the properties that created the display:
**Waterfall Chart Display**

Here is an example of a waterfall chart display:

![Waterfall Chart Display](image-url)
Select a Gauge for an Indicator

You select a gauge for an indicator when you create or edit an indicator. For more information, see “Create or Edit an Indicator” on page 54.

Note: A gauge is available only for certain types of displays.

To select a gauge for an indicator:

1. Select a gauge and, if available, a gauge style.
2. If you selected a dynamic gauge, follow these steps:
   a. Click at the top of the Properties pane.
The Gauge Properties dialog box appears.

b. To display range intervals (tick marks) on the gauge, select **Display range intervals**, and then select the format from the **Format range intervals** drop-down list.

c. To specify the dimensions of the gauge, in the **Gauge Size** area, do one of the following:
   
   - Select the **Dynamically scale gauges** check box, and then specify the number of columns
   - Clear the **Dynamically scale gauges** check box, and then type values for the height and width.

d. Specify how to orient the gauge: **Flip horizontal** (around the vertical axis) or **Flip vertical** (around the horizontal axis).
e. To change the colors in the image to create a ghost effect, select **Enabled** and a method.

These are the methods:

**Gray scale**
- The selected interval is a darker gray than the other intervals.

**Inactive color**
- The areas that are not pointed to are a specific color. To select the color, click

**Automatic ghost**
- The software determines how to best create the ghost colors for the intervals.
- To limit how far away from gray or a neutral color of equal intensity the image varies, type a value in the **Decrease saturation by (%)** field.
- To brighten the image, type a value in the **Brighten by (%)** field.
Chapter 10
Dashboards

Overview

Chapter 10
Dashboards

Overview

A dashboard is a container that has a collection of one or more indicators, and labels and images that enhance the dashboard. A dashboard can be displayed in a portlet on a page within the SAS Information Delivery Portal or in the dashboard viewer. For information, see “The Workflow” on page 5.

These are the objects that you combine to create a dashboard:

- Indicator data (see Chapter 7, “Indicator Data,” on page 37)
- Ranges (see Chapter 8, “Ranges,” on page 49)
- Indicators (see Chapter 9, “Indicators,” on page 53)
- Layout templates (see “The Layout Templates View” on page 32)
Dashboard Layout

You control how objects in a dashboard are laid out by selecting a Layout option in the dashboard properties.

- Horizontal Flow
  With the Horizontal Flow option, objects flow horizontally on a dashboard, and then wrap to new rows as needed.

- Precision
  With the Precision option, objects are placed on a dashboard at the precise location as specified by the object's left and top positions.

  Note: Objects can overlap or completely cover other objects when displayed in the dashboard viewer. Such overlapping might prevent dashboard users from being able to properly interact with the objects.

- Vertical Flow
  With the Vertical Flow option, objects flow vertically on a dashboard, and then wrap to new columns as needed.

You can change the layout method while creating a dashboard.

Indicator Interactions

Overview

Indicator interactions present dashboards with which a dashboard user can interact, enabling the user to explore data directly from within the dashboard.

When you add two or more indicators to a dashboard, you can choose to have one indicator interact with one or more other indicators. The first indicator (the source) influences a second indicator (the target). You specify this influence by mapping a source parameter to a target parameter.

Note: You can specify more than one target parameter.

See Also

- “Manage Dashboard Contents” on page 114
- “Set Up Indicator Interactions” on page 115
Example

Here is an example of a dashboard with two indicators. There is no interaction set up between them, so as a dashboard user explores data in one indicator, the other indicator remains static.

A dashboard administrator then modifies the indicators in the dashboard designer. The dashboard administrator sets up an interaction so that the source parameter Make in the Average City MPG indicator is mapped to the target parameter Make in the Car Detail Table indicator, and then selects the brush (highlight) interaction.

When a dashboard user clicks a car make in the Average City MPG indicator, here is what happens:

1. The parameter Make in the Average City MPG indicator is set to the car make that the dashboard user clicked.

2. The parameter Make in the Car Detail Table indicator is also set to the car make that the dashboard user clicked, because the parameter Make in the Average City MPG indicator is mapped to the parameter Make in the Car Detail Table indicator.

3. The interaction is then processed, which results in the car make being brushed (highlighted) in the Car Detail Table indicator.
In the dashboard designer, this indicator interaction is shown by an arrow from the Average City MPG indicator to the Car Detail Table indicator.

To display this arrow, the dashboard administrator selects the **Show interactions** check box from the dashboard's **Properties** pane.
Later, as a dashboard user explores data in the modified Average City MPG indicator, the car make clicked by the user highlights the car make data in the Car Detail Table indicator.

Parameter Mapping

For maximum flexibility, the source parameter and the target parameter are not required to have the same name; they merely need to reference the same type of data. For example, the source indicator can have a data column named REGION_ID and the target indicator can have similar data contained in a data column named SALES_REGION_ID. By mapping REGION_ID to SALES_REGION_ID, you link together the two data columns.

Further, the data can be contained in different data sources and different types of data sources. For example, a source indicator can have indicator data from an SQL query that maps to a target indicator that has indicator data from a stored process.

There are three types of interactions:

- brush
- client-side filter
- server-side filter

Note: If you define an indicator with both a hyperlink and an interaction, the hyperlink takes precedence over the interaction when the hyperlink opens in the same window as the interaction. For example, if you create a dashboard that opens a report and that
interacts with another indicator, when the dashboard user clicks the indicator, the report opens in the current window. If the hyperlink opens in a new window, then the dashboard user sees the interaction in the current window and the hyperlink in a new window.

**Brush Interaction**

A brush interaction specifies that when the dashboard user selects a specific value in the source indicator, related values in the target indicator are highlighted.

*Note:* You can specify more than one target indicator.

Any type of indicator data can be used for a brush interaction.

All display types can be the source for a brush interaction, except dynamic prompt, dynamic text, and the interactive displays.

All display types can be the target for a brush interaction, except KPI, dynamic prompt, dynamic text, and the interactive displays.

**Client-Side Filter**

A client-side filter interaction specifies that when the dashboard user selects a specific value in the source indicator, data in the target indicator is filtered, based on the selection.

*Note:* Do not specify a default value for the mapped parameters that severely limits the amount of data returned by the indicator data. This limited data, when filtered further by the client-side filter, can reduce the amount of data to few, or no, matching rows.

All display types can be the source for a client-side filter interaction, except dynamic text and the interactive displays.

All display types can be the target for a client-side filter interaction, except KPI and the interactive displays.

A client-side filter operates on data that is stored on the dashboard user's computer, so a client-side filter can operate against any target parameter, and a client-side filter can be very responsive. However, because a client-side filter requires that a target indicator first load all data on to the dashboard user's computer, load times might be long, and there is an upper limit to how much data can be used.

**Server-Side Filter**

**Overview**

A server-side filter is conceptually the same as a client-side filter, except that the parameters are put into the query and the query is sent to the middle tier (the server) with the new parameters. Generally, a server-side filter is not as responsive as a client-side filter because of the time required to communicate with the middle tier, and the target parameters can be only parameters that are understood by the query.

Unlike a client-side filter, which can be based on a target parameter that does not have a prompt defined in the target indicator data, a server-side filter can be based only on a target parameter that is defined in the target indicator data.

The only indicator data that can be used with a server-side filter is an information map or a stored process. In both cases, you must supply a default value for a prompt.
All display types can be the source for a server-side filter interaction, except dynamic text and the interactive displays.

All display types can be the target for a server-side filter interaction, except dynamic text and the interactive displays. The only indicator data that can be the target for a server-side filter is a relational information map and a stored process. In both cases, you must supply a default value for a prompt. An information map must also have at least one filter defined, and this filter must be a mapped parameter.

**CAUTION:**

*Do not change the default value of a prompt in another application while SAS BI Dashboard is running.* Log off from SAS BI Dashboard, change the value, and then log in again.

**Date Formats in Information Maps**

When using a prompt based on a date with an information map, ensure that you pass values to the prompt in a format that the prompt accepts.

Here are guidelines for each type of date:

- **DAY**
  
  You can pass values such as *August 04, 2010*, *Aug 04, 2010*, or *04AUG2010*. No other format is accepted.
  
  *Note:* The easiest way to ensure that the proper date format is accepted is to use a prompt with a format of DATE9 or MMDDYY10.

- **WEEK**
  
  You can pass a value such as *Week 31 2010*.
  
  *Note:* There is no SAS format that can create such as value. You have to create a custom data set or use SQL to create a data column with the correct format. Then, pass this data column as the source in the interaction or link.

- **MONTH**
  
  You can pass a value such as *Jan 2009*. No other format is accepted.
  
  *Note:* There is no SAS format that can create such as value. You have to create a custom data set or use SQL to create a data column with the correct format. Then, pass this data column as the source in the interaction or link.

- **QUARTER**
  
  You can pass a value such as *3rd quarter 2010*.
  
  *Note:* There is no SAS format that can create such as value. You have to create a custom data set or use SQL to create a data column with the correct format. Then, pass this data column as the source in the interaction or link.

- **YEAR**
  
  You can pass a value such as *2010*.

**Chaining Filters**

You can chain filters, such as indicator A that interacts with indicator B, which in turn interacts with indicator C.

*Note:* Although SAS BI Dashboard does not prevent you from defining a recursive filter interaction, it is not recommended. A recursive filter interaction might not provide the user with the expected result and might make further filtering of the data impossible.
Zooming

You can specify a zoom percentage for an object in a dashboard. The controls for the zoom of the width and the height are in the Properties pane for a dashboard.

Because SAS BI Dashboard shows you how a dashboard will appear to a dashboard user, zooming affects the appearance of a dashboard in these ways:

- Legends are not shown.
- Labels are not shown.
- Fonts get smaller in inverse proportion to the zoom values.
- Axes are not shown if you select Hide axes when zoomed out for the indicator.
- Titles are not shown if you select Hide titles when zoomed out for the indicator.
- Values are not shown if you select Hide values when zoomed out for the indicator.

These items reappear when you set the zoom factor to be 100% in both dimensions.

Note: When an object is contained by a horizontal or vertical flow container, the zoom setting of the flow container affects the contained objects in the same manner. For more information, see “The Layout Templates View” on page 32.

Create or Edit a Dashboard

When you edit a dashboard, you change it for all users.

To create or edit a dashboard:

1. In a dashboard portlet, click Manage Dashboards.

   The SAS BI Dashboard appears in a new browser tab.
2. Do one of the following in the **Library** view:
   - To create a dashboard:
     1. Select **Dashboard** from the **New** drop-down list.
        The Create a Dashboard dialog box appears.

        ![Create a Dashboard dialog box](image)

        2. Type the name, and then click **OK**.

   - To edit a dashboard, navigate to the dashboard, and then double-click its name.

3. After the dashboard and its **Properties** pane appear, set the dashboard's properties as needed.

4. To rename the dashboard:
   a. Select **File ⇒ Save As**.
      The Save As dialog box appears.

      ![Save As dialog box](image)

      b. Navigate to a location, name the dashboard, and then click **Save**.
Manage Dashboard Contents

Overview

As you interactively manipulate the contents of a dashboard, you can undo and redo your actions.

To manage the contents of a dashboard, create or edit a dashboard. For more information, see “Create or Edit a Dashboard” on page 112.

Add Content

To add content:

1. To add a horizontal or vertical flow container to the dashboard, drag one from the Layout Templates view of the Objects pane onto the dashboard.
   For information about flow containers, see “The Layout Templates View” on page 32.

2. To add an indicator to the dashboard, drag an indicator from the Library view of the Objects pane onto the dashboard or into a container.
   Note: You can add an indicator to the same dashboard only once.

3. To add a label or an image, drag one from the Static Content view of the Objects pane onto the dashboard.

4. To create a link from a label or an image, select the object, and then specify values for the properties in the Link Setup area of the Properties pane.

Align and Size Objects

To align and size objects:

1. Select the first object, to which other selected objects will be aligned or sized.

2. Hold down the CTRL key, and then select one or more objects.

3. Select an alignment or sizing option:
   • For alignment options, select Edit ⇒ Align, and then select an alignment method.
   • For size options, select Edit ⇒ Size, and then select a size method.
   • To display a grid of dots on the dashboard background, select View ⇒ Show Layout Guide.

Note: If there is only one object on the dashboard and you select the object and then an alignment, the object is aligned to the dashboard itself. For example, selecting a single indicator in the dashboard and then selecting Edit ⇒ Align ⇒ Align Top moves the indicator to the top of the dashboard.
Alter the Appearance of the Content

To alter the appearance of the content:

1. To see how the dashboard appears in the SAS BI Dashboard portlet, select View ⇒ Go to Dashboard Viewer.
   The dashboard replaces the SAS Information Delivery Portal in the same browser window.

2. To edit an object as it appears on the dashboard, select the object, and then specify its properties on the Properties pane.

3. To edit an object, use the buttons on the object's toolbar.
   For more information, see “Editing an Object” on page 33.

Set Up Indicator Interactions

For information about indicator interactions, see “Indicator Interactions” on page 106.

To set up indicator interactions:

1. Add at least two indicators to a dashboard.
   For more information, see “Manage Dashboard Contents” on page 114.

2. Select the indicator that will be the source of the interaction, and then select Edit ⇒ Set Up Interactions.
   The Set Up Indicator Interactions dialog box appears.

3. From the Target Element column, select the check box next to each element that you want to be a target.

4. From the Type drop-down list, select the type of interaction.

5. Select the source parameter and the target parameter.

After you have set up the interactions, in the dashboard properties, select the Show interactions check box.
Controlling the Appearance of a Dashboard Using the Flow Containers

Dimensions and Wrapping

When the SAS BI Dashboard draws the indicators within a dashboard, the indicators are wrapped into rows or columns based on the width or height specified for the individual indicators and the dimensions of the container. For example, if a dashboard has ten indicators with a width of 180 pixels each, the total required width for the dashboard portlet is 1800 pixels. If the dashboard is only 1000 pixels wide, then two rows of indicators appear. If the first indicator is 900 pixels wide, then three rows of indicators appear.

The indicator width is specified when you define the display for an indicator.

There are two more sizing factors that affect the display of a dashboard. All of these factors interact in different ways to determine how a dashboard is laid out. All of the factors are described in this table:

<table>
<thead>
<tr>
<th>Factor</th>
<th>Where to Specify the Values</th>
<th>Purpose</th>
<th>Is It Ignored?</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dashboard portlet dimensions</td>
<td>The dimensions are specified when you edit the content of a portlet. For more information, see “Specify the Dashboard Dimensions” on page 16.</td>
<td>This factor specifies the dimensions of the dashboard portlet.</td>
<td>Never ignored. If the content is larger than the portlet’s dimensions, scroll bars appear.</td>
</tr>
<tr>
<td>Indicator dimensions</td>
<td>The dimensions are specified when you define the display for an indicator.</td>
<td>This factor specifies the preferred dimensions of the indicator.</td>
<td>The width is ignored when a graph display type specifies the Output type as Image or a gauge width is larger. For example, if a KPI display contains more than one gauge, the gauges are wrapped into rows according to the width of the indicator. The height is ignored.</td>
</tr>
<tr>
<td>Graph display, bar chart with reference lines display, and range map display dimensions</td>
<td>The dimensions are specified when you define the indicator display.</td>
<td>This factor specifies the dimensions of a graph inside of an indicator.</td>
<td>Never ignored. If a graph display type specifies the Output type as HTML and there is more content than the dimensions allow, scroll bars appear.</td>
</tr>
</tbody>
</table>
Based on these factors and how they control the appearance of a dashboard, here are some guidelines that are important to good dashboard layout:

- With a dynamic gauge, you can use disproportionate dimensions to create extra white space around a gauge.

- A single KPI display that contains multiple gauges will manage the horizontal alignment correctly. But if there are several different indicators, each with just one dynamic gauge, then you might need to manipulate the heights of the various dynamic gauges to correctly align the indicators.

This problem often occurs when the title of one indicator has two lines of text and the adjacent indicators have only one line of text. The extra line of text causes the indicator to be positioned farther down the page than the rest of the indicators in the row. By setting the height for that one indicator to less than the heights of the others, you can get the whole dashboard properly aligned.

- An indicator width that is less than the dynamic gauge width or graph width causes scroll bars to appear in the dashboard portlet. If you want everything to wrap nicely, ensure that the indicator width is larger than the dynamic gauge width or the graph width.

- To vertically align several graphs, specify the same width for all of the indicators in the column.

**Fonts**

Here are some general guidelines for specifying fonts in a dashboard:

- For the best appearance of fonts in a dashboard, specify the same zoom value for all of the indicators in the dashboard. Set the zoom width and height to the same value, generally between 100% and 300%.

- In the **Font Settings** area, some of the types that you can select include (preferred) in the name. Preferred means that the size of the font that you specify applies only if the graph is large enough to accommodate the text. But the graph component determines the best size of the font, which is based on the size of the graph and an algorithm that shrinks text so that the graph and the text are legible at smaller sizes.
Part 4

Appendix

Appendix 1

*Indicator Role-Mapping Properties* .......................... 121
Appendix 1
Indicator Role-Mapping Properties

Overview

Alphabetic List of Properties

2nd Y axis value
Actual legend label
Actual value
Alternate forecasted value to summarize
Alternate lower confidence to summarize
Alternate upper confidence to summarize
Alternate value to summarize
Band legend label
Bar value
Bubble size value
Bullet value
Cluster group
Column group by
Custom label for summary graph
Default data color
Detail axis format
Detail X axis format
Detail Y axis format
Difference
Difference axis format
Finish date
Forecast range value
Forecasted legend label
Forecasted value
Forecasted X value
Forecasted Y value
Format
Group by value
Hide axis tick labels
Hide axes when zoomed out
Hide reference lines
Hide titles when zoomed out
Hide values when zoomed out
Hide vector arrows
Highlight last row
Image URL
KPI title
Lines for title
Lower band
Lower confidence ................................................................. 127
Menu value ........................................................................... 127
Point label ............................................................................. 127
Primary value ......................................................................... 127
Prompt type ........................................................................... 127
Range ....................................................................................... 127
Range data source ............................................................... 127
Range value ........................................................................... 127
Range value 2 ......................................................................... 128
Row group by .......................................................................... 128
Scale X axis ............................................................................. 128
Scale Y axis ............................................................................. 128
Secondary value ....................................................................... 128
Show labels ............................................................................. 128
Show legend ............................................................................ 128
Spark group by ......................................................................... 128
Spark X axis ............................................................................. 128
Stack group ............................................................................. 128
Start date ................................................................................ 129
Static text ................................................................................ 129
Summarization function ......................................................... 129
Summarization graph type ...................................................... 129
Summarize by .......................................................................... 129
Summary axis format .............................................................. 129
Target value ............................................................................ 129
Task ......................................................................................... 129
Tile by ....................................................................................... 129
Tile size .................................................................................... 129
Upper band .............................................................................. 129
Upper confidence .................................................................... 130
Use proxy ................................................................................ 130
X axis ......................................................................................... 130
X axis format ........................................................................... 130
X axis labels ............................................................................. 130
X axis title ................................................................................ 130
X axis value ............................................................................. 130
X end value ............................................................................... 130
X lower confidence .................................................................. 130
X start value ............................................................................ 130
X upper confidence ............................................................... 131
X value ...................................................................................... 131
Y axis format ........................................................................... 131
Y axis title ................................................................................. 131
Y axis value ............................................................................. 131
Y end value ............................................................................... 131
Y lower confidence .................................................................. 131
Y start value ............................................................................ 131
Y upper confidence ............................................................... 131
Y value ...................................................................................... 131
Overview

You use the role-mapping properties when you create or edit an indicator. For more information, see “Define the Role-Mapping Properties” on page 56.

Alphabetic List of Properties

2nd Y axis value
The parameter to use for the point value for a secondary line on a line chart.

Actual legend label
The text that replaces the default legend label for the actual value in a forecast chart display.

Actual value
The parameter to use for the actual value in a forecast chart display.

Alternate forecasted value to summarize
The alternate parameter to use for the forecasted value summarization.
The summarized value is used to draw the summary line or bar chart at the bottom of the interactive charts.

Alternate lower confidence to summarize
The alternate parameter to use for the lower confidence summarization.
The summarized value is used to draw the summary line or bar chart at the bottom of the interactive charts.

Alternate upper confidence to summarize
The alternate parameter to use for the upper confidence summarization.
The summarized value is used to draw the summary line or bar chart at the bottom of the interactive charts.

Alternate value to summarize
The alternate parameter to use for the summarization.
The summarized value is used to draw the summary line or bar chart at the bottom of the interactive charts.
**Band legend label**

The text that replaces the default title for the band legend in a forecast chart.

**Bar value**

The parameter to use for a bar.

**Bubble size value**

The parameter to use for the size of bubbles in a bubble chart display.

**Bullet value**

The parameter to use for a bullet in the bar chart with bullet display.

**Cluster group**

The parameter to use for a cluster in a clustered bar chart.

**Column group by**

The parameter by which to group columns of data.

**Custom label for summary graph**

The text that replaces the default title for the summary graph in an interactive display.

**Default data color**

Specifies the default color for representing data in an interactive display.

**Detail axis format**

The SAS format applied to the data on the Detail axis.

**Detail X axis format**

The SAS format applied to the data on the Detail X axis.

**Detail Y axis format**

The SAS format applied to the data on the Detail Y axis.

**Difference**

The parameter to use for each bar, which is an offset of the ending value for the previous bar, in a waterfall chart display.
The magnitude of the last bar in the chart is the sum of the differences of all previous bars. If the values in the difference column are -500, 700, 100, the first bar goes from 0 to -500, the second bar goes from -500 to 200, and the third bar goes from 200 to 300.

**Difference axis format**

The SAS format applied to the data on the Difference axis.

**Finish date**

The parameter to use for the finish date of a task in the schedule chart. For more information about the schedule chart display type, see “Schedule Chart Display” on page 90.

**See Also**

“Start date” on page 129

**Forecast range value**

The parameter to use for the forecasted value, which is used for range coloring of the forecasted values in an interactive summary and targeted bar chart display.

**Forecasted legend label**

The text that replaces the default legend label for the forecasted value in a forecast chart. For more information about the forecast chart display, see “Forecast Chart Display” on page 72.

**Forecasted value**

The parameter to use for the forecasted value in a forecast chart.

**Forecasted X value**

The parameter to use for the forecasted value for the X axis value for an interactive summary and scatter plot chart display.

**Forecasted Y value**

The parameter to use for the forecasted value for the Y axis value for an interactive summary and scatter plot chart display.

**Format**

The SAS format applied to the data in a column.

**Group by value**

The parameter by which to group data.
Hide axis tick labels
Specifies that axis tick labels are hidden. This setting avoids clutter.

Hide axes when zoomed out
Specifies that gauge axes are hidden when an indicator is zoomed out. This setting avoids clutter. When you zoom in, the axes are displayed.

Hide reference lines
Specifies that reference lines are hidden. This setting avoids clutter.

Hide titles when zoomed out
Specifies that gauge titles are hidden when an indicator is zoomed out. This setting avoids clutter. When you zoom in, the titles are displayed.

Hide values when zoomed out
Specifies that gauge values are hidden when an indicator is zoomed out. This setting avoids clutter. When you zoom in, the values are displayed.

Hide vector arrows
Specifies that arrowheads are hidden.

Highlight last row
Specifies that the last row in a spark table is highlighted.
When the source data table uses the last column for summarization, highlighting the last row emphasizes the summarized values.

Image URL
The URL to an image or other information in a custom graph display.
For more information about how to use Image URL, see “Custom Graph Display” on page 67.

KPI title
The parameter to use for the title of a KPI gauge.

Lines for title
The number of lines to reserve for the title of a KPI gauge. If there is no text on the line, the line is displayed as blank.
**Lower band**

The parameter to use for the lower confidence band in a forecast chart.

*See Also*

“Upper band” on page 129

**Lower confidence**

The parameter to use for the lower confidence boundary in an interactive display.

*See Also*

“Upper confidence” on page 130

**Menu value**

The parameter to use for the values available in the drop-down list in a dynamic prompt display.

**Point label**

The parameter to use for the label for a data point.

**Primary value**

The parameter to use for the primary data line in a line chart with reference lines.

*See Also*

“Secondary value” on page 128

**Prompt type**

The type of prompt to display for a dynamic prompt display.

**Range**

A saved range.

**Range data source**

The parameter to use with a range.

**Range value**

The parameter to use for a range.
Range value 2
The parameter to use for a range for a second indicator.

Row group by
The parameter by which to group rows of data.

Scale X axis
Specifies that a scroll bar appears on the X axis to allow the user to zoom the axis in and out.

Scale Y axis
Specifies that a scroll bar appears on the Y axis to allow the user to zoom the axis in and out.

Secondary value
The parameter to use for the secondary tick value displayed on a gauge.
This value does not affect the colors of the gauge.

See Also
“Primary value” on page 127

Show labels
Specifies that labels are displayed for data groups.

Show legend
Specifies that the legend is displayed for a graph.

Spark group by
The value by which to group a spark table.
Multiple rows of data are condensed into a single row.

Spark X axis
The parameter to use for the X axis for a column’s spark line (graph).
If there are multiple spark line data columns in a table, each data column must use the same X axis value.

Stack group
The parameter to use for grouping a stacked bar chart.
**Start date**

The parameter to use for the start date of a task in the schedule chart.

*See Also*

“Finish date” on page 125

**Static text**

The text to display for a dynamic text indicator.

Type `@var1@` where you want to display the value for the range. The range value replaces `@var1@`.

**Summarization function**

The function to use to summarize data in an interactive display.

**Summarization graph type**

The type of graph to use to represent summary data in an interactive display.

**Summarize by**

The parameter to use to summary data in an interactive display.

**Summary axis format**

The SAS format applied to the data on the summary axis.

**Target value**

The parameter to use for target values in a targeted bar chart.

**Task**

The parameter to use for the name of a task in a schedule chart.

**Tile by**

The parameter to use to create individual tiles in a tile chart display.

**Tile size**

The parameter to use to size individual tiles in a tile chart display.

**Upper band**

The parameter to use for the upper confidence band in a forecast chart.
See Also
“Lower band” on page 127

Upper confidence
The parameter to use for the upper confidence boundary in an interactive display.

See Also
“Lower confidence” on page 127

Use proxy
Specifies that a server proxy is used in a custom graph display.
For more information about how to use Use proxy, see “Custom Graph Display” on page 67.

X axis
The parameter to use for the data on the X axis.

X axis format
The SAS format applied to the data on the X axis.

X axis labels
Specifies how to display the labels on the X axis.

X axis title
The text that replaces the default title for the X axis.

X axis value
The parameter to use for data on the X axis.

X end value
The parameter to use for the ending value for the X axis.
For more information, see “X start value” on page 130.

X lower confidence
The parameter to use for the lower confidence boundary on the X axis in an interactive display.

X start value
The parameter to use for the beginning value for the X axis.
For more information, see “X end value” on page 130.

**X upper confidence**

The parameter to use for the upper confidence boundary on the X axis in an interactive display.

**X value**

The parameter to use for data on the X axis.

**Y axis format**

The SAS format applied to the data on the Y axis.

**Y axis title**

The text that replaces the default title for the Y axis.

**Y axis value**

The parameter to use for the data on the Y axis.

**Y end value**

The parameter to use for the ending value for the Y axis.

For more information, see “Y start value” on page 131.

**Y lower confidence**

The parameter to use for the lower confidence boundary on the Y axis in an interactive display.

**Y start value**

The parameter to use for the beginning value for the Y axis.

For more information, see “Y end value” on page 131.

**Y upper confidence**

The parameter to use for the upper confidence boundary on the Y axis in an interactive display.

**Y value**

The parameter to use for data on the Y axis.
## Index

### A
- alerts
  - add users and user groups 59
  - create or edit 58
  - create or edit personal in the dashboard viewer 19
- automatic refresh 16, 18

### B
- bar chart with bullet indicator display 59
- bar chart with reference lines indicator display 61
- bubble plot indicator display 64

### C
- Category Label data column 40
- chart with slider prompt indicator display 65
- clustered bar chart indicator display 66
- Column Name data column 40
- comments
  - manage in dashboard viewer 21
  - refresh in dashboard viewer 18
- custom graph indicator display 67

### D
- dashboard designer 7
- dashboard dimensions
  - specify 16
- dashboard or indicator
  - open in dashboard viewer 17
- dashboard viewer 6
  - create or edit alert 19
  - create or edit indicator alert 19
  - create or edit personal alert 19
  - display options 18
- favorites 23
- manage comments 21
- navigation controls 18
- open dashboard or indicator 17
- refresh contents 18
- dashboards
  - alignment of objects while creating 114
  - create or edit 112
  - display in dashboard viewer 17
  - layout 106
  - manage 7
  - manage contents 114
  - preview while creating 115
  - print from a portlet 16
  - print from dashboard viewer 19
  - select 15
  - size of objects while creating 114
  - view 6
- data columns
  - Category Label 40
  - Column Name 40
  - Hyperlink 41
  - Label 40
  - Property Alias 41
- data models
  - See indicator data
- data sources
  - information map 43
  - SQL query 44
  - stored process 45
  - table 46
- Default views 18
- display options
  - in dashboard viewer 18
- dual line chart indicator display 69
- dynamic gauges 79
- dynamic indicator display 70
- dynamic text indicator display 71

### F
- favorites
Index

in dashboard viewer 23
forecast chart indicator display 72

G
gauges
  select 102

H
horizontal flow container 32
Hyperlink data column 41

I
Image static content objects 32
indicator alerts
  create or edit personal in the dashboard viewer 19
indicator data
  create or edit 42
  define a stored process data source 45
  define a table data source 46
  define an information map data source 43
  define an SQL query data source 44
indicator data rules 38
indicator displays 59
  bar chart with bullet 59
  bar chart with reference lines 61
  bubble plot 64
  chart with slider prompt 65
  clustered bar chart 66
  custom graph 67
  dual line chart 69
dynamic 70
dynamic text 71
forecast chart 72
interactive 73
  interactive summary and bar chart 74
  interactive summary and scatter plot 75
  interactive summary and targeted bar chart 76
KPI 77
  line chart with reference lines 81
  needle plot 83
  pie chart 84
  range map 85
  scatter histogram 87
  scatter plot 88
  schedule chart 90
  simple bar chart 91
  spark table 92
  stacked bar chart 94
  targeted bar chart 96
tile chart 98
vector plot 99
waterfall chart 101

indicators
  create or edit 54
  print from a portlet 16
  print from dashboard viewer 19
  select gauge 102

information map data sources
  define 43
  interactive indicator display 73

K
KPI displays
  overview 77
  KPI indicator display 77

L
Label data column 40
Label static content objects 32
layout of dashboards 106
Layout Templates view 32
library tree
  refresh 29
Library view 28
line chart with reference lines indicator display 81

N
navigation controls
  in dashboard viewer 18
  needle plot indicator display 83

O
objects
  editing 33
  move 34
  resize 34
  search for 29

objects in dashboard
  alignment options while creating 114
  size options while creating 114

Objects pane 28
Layout Templates view 32
Library view 28
Static Content view 32
options
  open the previously viewed dashboard or indicator by default 18

P
personal alerts
create or edit in the dashboard viewer 19
pie chart indicator display 84
preview dashboards 115
Properties pane 34
Property Alias data column 41

R
range map indicator display 85
ranges
create or edit 49
manage 49
refresh
automatic 16, 18
manual 16, 18

S
SAS BI Dashboard portlet
add to SAS Information Delivery Portal 11
specify the default view 18
SAS Information Delivery Portal
add a SAS BI Dashboard portlet 11
create a page 10
log on 9
overview 9
saved objects
search for 29
scatter histogram indicator display 87
scatter plot indicator display 88
schedule chart indicator display 90
simple bar chart indicator display 91
spark table indicator display 92
SQL query data sources
define 44
stacked bar chart indicator display 94
Static Content view 32
stored process data sources
define 45

T
table data sources
define 46
targeted bar chart indicator display 96
tile 33
tile chart indicator display 98

U
users and user groups
add 59

V
vector plot indicator display 99
vertical flow container 32

W
waterfall chart indicator display 101
workspace 32
workspaces
minimize or maximize 33
Index
Your Turn

We welcome your feedback.

- If you have comments about this book, please send them to yourturn@sas.com. Include the full title and page numbers (if applicable).
- If you have comments about the software, please send them to suggest@sas.com.